
General Features 

This section details general features of EasiSlides. Some of the features detailed are also found in 
the 'Getting Started' help section.  

Most these features are applicable to Database and Bible items only. 

Manage Worship Sessions 

A Worship Session holds details on worship settings (such as Display Panel preferences) and the 
Worship List to use during a Show.  

In a Christian Church/Fellowship environment, you could have a Morning Service, a Sunday School, 
an Evening Service, all of which will have their own songs, and preferences, during the meeting. 
The Worship Session gives each meeting's worship leader his/her own worship list and settings to 
use.  

The Worship Session does not have to be Meeting based. For example, it could be the name of a 
Worship Leader, instead of 'Morning Service', to be used by him/her for any worship meetings he is 
going to lead. 

? To Manage Worship Sessions, click the  button.  

When the Manage Worship Sessions window appears on screen, you can do the following: 

? Create New Worship Session 

Click the Create  button create a new Worship Session. The Worship List for the newly created 
Session will be blank. 

? Rename Worship Session  

Select one Worship Session and click the Rename  button to rename the selected Session 
name to something else.  

? Delete Worship Session  

Select one Worship Session and click the Delete  button to delete the selected Session and 
the associated Worship List. 

Note: Worship Sessions are actually Text Files with some EasiSlides formatting information. The 
files are stored in C:\EasiSlides\Admin\WorshipLists and therefore you may, if you wish but with 
caution, use Windows to amend, delete, rename them as desired. 

Add a Song to the Database 

The Header Information: 

1. From the Main Screen, Select the Folder Tab , then click the Add  button:   
2. When the EasiSlides Editor appears, most of the fields will be blank. At this stage, you can 

changed the Font name and size for the Main Font and for the Notations Font. These settings 
are for the editor only and will not affect the way the song appears when it is used during 
worship. The settings will be retained for subsequent editing of other songs.  

3. Enter the Song Title  and select the Folder to store the song. You can also enter other 
optional information such as Song Number, Writer, Copyright and Licence Admin information 
(eg. CCLI).  

4. The Song Number is a numeric field to store your own Song Number.  
5. The  Title 2  field is for an alternative name for the song and is useful in situations where the 
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Main title is non-English and therefore Title 2 can be the English title. EasiSlides will make use 

of both Title and Title 2 fields when searching for music files. The  button beside Title 2 will 
help you to search on Titles in the database and if you select one form the searched list, 
EasiSlides can also insert the Book/User Reference from the selected title.   

6. The Book Reference is initially used by EasiSlides to hold song number references for the 
song in Songs of fellowship, Complete Mission Praise and The Source. For example, the song 
All Heaven Declares will have the Book Reference of “SF10, MP14, TS8” which means the 
song is at: 
- Songs of Fellowship No. 10 
- Complete Mission Praise No. 14 
- The Source No.8  

7. The User Reference is a user field for you to use for whatever purposes you want. The 
Search option can search on this field.  

The Song Lyrics: 

1. You can use the  button, or use drag and drop to drag, to import a Word or text document 
from a Windows folder into the Lyrics area. If so, the Document name will become the Title 
and the contents of the Word/text Document will be inserted into the Lyrics Area.  

2. Type up the lyrics for the song in the Lyrics Area . There are two Lyrics areas - Region 1 and 
Region 2. Use the following buttons to indicate verse number, chorus, etc. (Note: Apart from 
the New Screen indicator, all other indicator can only appear once in the lyrics)  

Please see EasiSlides Regions Explained for more information on 
Regions. 

3. The Sequence information  tells EasiSlides the order the various verses, chorus, bridge, 
ending are to be sung. If you leave the Sequence blank, EasiSlides will show the lyrics in the 
order the lyrics are typed in. Use the following buttons to arrange the Sequence as 
appropriate: 

4. To add Notations, insert a blank line above the line of lyrics and at the blank line, click the 

 button which will insert the notation symbol into your blank line. Now add your notations 
as desired. Typical notations are guitar chords. An alternative way to add guitar chords is 
to click on the lyrics where you want a guitar chord to appear above it, then right click mouse 
and select from list of available chords. You will need to ensure the  button is clicked to see 

 .. Insert a Verse Number heading

 Insert Chorus/Chorus2 Heading

  Insert Bridge/Bridge2 Heading

  Insert PreChorus/PreChorus2 Heading

Insert Ending Heading

Insert New Screen - this actually inserts a blank 
line in the lyrics which is automatically 
translated to a New Screen during the Show.

  Undo, Redo typed text 

Add the selected indicator(s) to the Sequence List 

Smart-Add all the indicators to the Sequence List. 
EasiSlides will make an educated guess at what the 
Sequence should be.

 
Rearrange the order of the selected item in the 
Sequence List

Remove the item from the Sequence List
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the guitar chords popup menu. Below is an example of chords for the song "Away in a 
manger": 

 

5. The Verse Format  button  is for translating simple verse indicators to EasiSlides format 
one. Below is an example of text with simple verse indicators on the left and clicking the 
Verse Format button to produce the result on the right: 

 

6. If you wish, you can use the ,  buttons to transpose the guitar chords you have typed. If 
you had selected a capo setting and/or a Song Key, EasiSlides will also transpose those 
settings for you.  

7. If you type in Chinese, you can use the  button to switch your Traditional Chinese text to 
Simplified Chinese and vice versa.  

8. If you wish to set up Rotate Timings for the Song, please read the article Setting Rotate 
Timings.  

9. Click the  to save the Song to the Database. The system will inform you if there is an error 
in the lyrics or squence. If there are no errors, the system will save the song to the EasiSlides 
database.  

Setting Rotations:  
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For information on Rotations, please see the topic Setting Rotations. 

Note 1: You can store duplicate Song Titles. In such an event, you may wish to use brackets, eg. 
"(altd)" in the title to identify songs with the same name. 

Note 2: When transposing chords, EasiSlides will only consider the letters A to G  as a chord if there 
is a space, a "/" (for Bass), a "[" or a "{" before it. For example [G] is Chord G, as is {G}, as is G 
on its own. However, CG will only be considered as Chord C because the G after it is assumed to be 
part of C because there is no space in between. However C/G will both be transposed because C is 
the Chord and G is the Bass Note. Please be aware that you can not use the symbols "(" and ")" in 
the Notations because it is used by EasiSlides as internal indicators.  

Note 3 : A consistent format for the Title would be useful, ie. all titles to be based on first few 
words of the first line of song (Song "Because He Lives" would be stored under "God Sent His Son")  

Note 4 : With the first press of the  switch, if the text is either completely Traditional Chinese or 
a mixture of Simplified/Traditonal Chinese, EasiSlides will switch all the text to Simplified Chinese. If 
all the text had been Simplified Chinese then EasiSlides will switch all text to Traditional Chinese. 

  

Setting Rotations  

You can set a database item or an InfoScreen to rotate through its contents, slide by slide, during a 
Live Show.  

To Set a Rotation Style for an item  

1. Edit the Database item or InfoScreen you wish to rotate and set the Rotate Style.  
2. In the editor, select the Rotate Style tab.  
3. If you select the Simple Rotation  option, set a time, in seconds, for the time each slide is to 

appear on screen. A setting of 0 seconds effectively means No Rotation.  
4. If you select the Rotate Sequence  Option, you can do the following:- 

? Set the the verses and sequence order for the rotation  
? With each verse you add to the sequence, timing box(es) will appear. If a verse has 

been dividing into a number of Screens, you will get a timing box for each screen.  
? At each timing box you can set the time, in seconds, when the slide should appear.  
? Alternatively select a sample media file in the filename text box to help you to set the 

timings. After selecting the media file, click the play button to start the media. The 
Length Indicator will be updated and Position indicator will start.  

? Use the  button to set the Length of the media  

? Use the  button to add the current Position to the next unfilled timing box.  
? Please make sure all the timing boxes are filled in. note that the Sample media file 

name is not saved with the item. It is only used for you as reference to set timings.  
5. The rotation is now set for the item. Save the item and exit.  

To associate a Media Item with the Rotation  

1. If you wish to play a media file along with your rotation during a Live Show, you must 
associate the media file with the item, using the Media button at the Default Settings, or at 
Individual Settings. Please see Play Media for details.  

To Enable Rotation for a Live Show  

1. Place the Rotating item(s) onto the Worship List.  
2. If you wish them to rotate one after another, place them together on the Worship List without 

any other items separating them.  
3. At the EasiSlides Main Window, select the desired AutoRotate Options:- 

?  - If clicked - Do not Auto-Rotate  any slides. See Note 2.   

Page 4 of 28Database Features

24/08/2006file://C:\Documents and Settings\Mo\Local Settings\Temp\~hh4B85.htm



?  - Auto-Rotate One Item. Will Auto-Rotate the currently displayed item once only 
during a Live Show if the selected item has a Rotate Style set.  

?  - Auto-Rotate One Item - Repeat . Will Auto-Rotate the currently displayed item 
during a Live Show if the selected item has a Rotate Style set. When it finishes, start 
the rotation again from the start and keep on repeating the same item.  

?  - Auto-Rotate Group. If there is a group of items and each of those items have a 
rotate style set, then EasiSlides will take each item in turn and auto-rotate the slides in 
each item and then moving on to the next item after the current item's rotation is 
finished. If the end of the group of Rotating items is reached, EasiSlides will stop the 
Auto Rotation.  

?  - Auto-Rotate Group - Repeat. If there is a group of items and each of those 
items have a rotate style set, then EasiSlides will take each item in turn and auto-
rotate the slides in each item and then moving on to the next item after the current 
item's rotation is finished. If the end of the group of Rotating items is reached, 
EasiSlides will move to the first item of the rotating group and start the Auto Rotation 
all over again.  

4. Start the Live Show with the item you wish to rotate. During the Live Show, the item will start 
to Rotate based on the style you had set.  

5. If you had associated a Media File with the item, the Media will start in sync with the rotation 
and the effect is like that of a Karaoke System.  

NOTE 1:  If you have selected a non-repeating rotation option, ie. Auto -Rotate One Item or 
Auto -Rotate Group, when the rotation finishes, EasiSlides will either:- 

? Stop at the last slide if there is no Gap Item set, or  
? Stop at the selected Gap Item if there is a Gap Item set.  

NOTE 2:  If you choose the option Do not Auto-Rotate , it will also stop any media from playing 
automatically during the Live Show. If you wish to start the media and associated rotation manually 
when the item is displayed during a Live Show, press key F5. This will re-start the current item 
from the first slide and rotations and media, if any, for the item. Rotations and media will play until 
the end and then stops, ie. will not repeat nor move to next item. Please note that pressing F5 will 
also turn off Auto-Rotate if it was set on. 

Edit a Database Song 

To edit a Database Song: 

1. Select the song you wish to edit in the Songs List by clicking on it.  

2. Click the  button.  
3. The EasiSlides Song window will appear on screen.  
4. Update all the details for the song, including title and folder.  
5. Click  button to save the changes, or click  to save and then exit the editor automatically 

Please see Add a Song to the Database for details on verse indicators, sequence and available 
fields. 

Copy Songs 

You can make a copy of any of the songs displayed in the Songs List Area: 

1. Select the song(s) you wish to copy in the Songs List area.  
2. Click the  button.  
3. A Window will open allowing you to either select a song folder to copy to, or to copy the song

(s) as InfoScreen(s).  
4. Click on the desired Folder.  
5. Click the OK  button and EasiSlides will copy the selected Song(s) to the chosen folder.  
6. The copied items in the new folder will be highlighted in the Songs List window.  
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The above instructions can also be applied to copying InfoScreens.  

Move Database Songs 

You can move any of the songs displayed in the Songs List Area from their current Song Folder to 
another Song Folder: 

1. Select the song(s) you wish to move opy in the Songs Available area.  
2. Click the  button.  
3. A Window will open asking you to select a Folder to move the songs to.  
4. Click on the desired Folder.  
5. Click the OK  button and EasiSlides will move the selected Song(s) to the chosen folder.  
6. The moved items will be highlighted in the Songs List window.  

  

Delete Songs in the Database  

To delete song(s) from the Folders, do the following: 

1. Select the song(s) you wish to delete in the Songs Available area.  

2. Click the  button  
3. You will be prompted to confirm the deletion  
4. Click Yes to delete the selected songs.  

Note: When you delete Songs, the deleted songs are placed in the Deleted folder . At a later stage, 
you can either recover the deleted song(s), or empty the Deleted Folder which will permanently 
delete all the songs in the Deleted Folder.  

Find Items 

You can search the EasiSlides Database on Songs and Bible phrases:  

Quick Search  

1. At the main Screen, select either the Folders tab or the Bibles tab.  
2. Type the search phrase in the search box (see image below) and press the enter key on the 

keyboard.  
3. If you had selected the Folders tab, the search will search all the folders and all database 

fields for the search phrase you entered. The results, if any, will be displayed in the Folders 
area  

4. If you had selected the Bibles tab, the search will search the currently selected Bible for the 
search phrase, using exact match option. The Bible Passages found will be displayed in the 
Bible Passages area.  

 

Search Database Songs 

1. From Main Screen, click the  button to bring up the Search Window  
2. Click the Folder search Tab  
3. Type the search phrase (EasiSlides will base its search on the whole phrase entered)  
4. Select/Deselect the folders you wish to search on.  
5. Tick and Untick other options as appropriate.  
6. Click the Search button to start search.  
7. A list of songs (if any) which matches the phrase, selected folders and ticked options will be 

displayed in the Songs List area.  
8. The Search Box will remain open for you to make further searches if required. You can work 
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at the EasiSlides Main Window even if the Search Box is open.  

Search the Bible  

1. From Main Screen, click the  button to bring up the Search Window  
2. Click the Bible Search tab  
3. Select Bible Version and Book and type in the Search phrase.  
4. Select the search option as appropriate.  
5. Click the Search button to start search.  
6. A list of Bible Passages (if any) which matches the phrase and search option, displayed in the 

Bible Passages Area.  
7. The Search Box will remain open for you to make further searches if required. You can work 

at the EasiSlides Main Window even if the Search Box is open.  

  

Re-arrange Song Folders  

You can re-arrange the order of the Song Folders by doing the following: 

1. Select Edit->Re-arrange Song folders  from the EasiSlides Main Menu.  
2. When Re-Arrange Folders Positions window appears, click on the folder you want to move and 

use the   buttons to move it to the new position desired.  
3. Repeat the the above step for other folders you want to re-arrange.  
4. Click apply when you are content with the new order for the Song Folders.  
5. EasiSlides will take a few moments to complete the process. Once completed, you will see the 

re-arranged Song Folders in the Main EasiSlides Window.  

  

Background Images 

EasiSlides provides the ability to display background images for Database items. A number of public 
domain images are supplied with the EasiSlides Software and they are grouped in their respective 
subfolders as: 

? Scenery  
? Tiles  

Using your own images: 

If you wish to use your own images for EasiSlides, you should store them in the EasiSlides 
Images Folder in Windows which is normally " C:\EasiSlides\Images\". 

You can sub-divide the EasiSlides User Images Folder to group your user images into different 
groupings. For example, you wish to group your images into Cross and a second called Landscapes. 
In this case, all you have to do is to create two sub folders in the User Images folder to hold your 
images, like thus:  

? C:\EasiSlides\Images\Cross\  
? C:\EasiSlides\Images\Landscapes\  

Using the above example, when you list the Images Folders within EasiSlides, you will now see: 

? Scenery  
? Tiles  
? Images  
? \Cross  
? \Landscapes  
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Apart from the EasiSlides Images Folder, EasiSlides also allows you to add background images 
stored elsewhere on your PC. 

Please see Add Background Image for more information on how to use images for the Show. 

Add/Edit InfoScreen 

Use InfoScreens to type up/store Welcome Screens, Order of Services, Announcements, 
Testimonies and any other non -database items. Editing InfoScreens is exactly as that of editing a 
Database item except with InfoScreens, the data is stored in an XML file rather than in the 
EasiSlides database.  

The Header Information: 

1. From the Main Screen, Select the InfoScreens Tab, then click the Add button , or select 

an existing InfoScreen and click the Edit button   
2. When the EasiSlides Editor appears, most of the fields will be blank. At this stage, you can 

changed the Font name and size for the Main Font and for the Notations Font. These settings 
are for the editor only and will not affect the way the song appears when it is used during 
worship. The settings will be retained for subsequent editing of other songs.  

3. Enter the Song Title  and select the Folder you want the InfoScreen to be associated with. 
The format of the lyrics will be based on the song folder you select. You can also enter other 
optional information such as Song Number, Writer, Copyright and Licence Admin information 
(eg. CCLI).  

4. The Song Number is a numeric field to store your own Song Number.  
5. The  Title 2  field is for an alternative name for the song and is useful in situations where the 

Main title is non-English and therefore Title 2 can be the English title. EasiSlides will make use 

of both Title and Title 2 fields when searching for music files. The  button beside Title 2 will 
help you to search on Titles in the database and if you select one form the searched list, 
EasiSlides can also insert the Book/User Reference from the selected title.   

6. The Book Reference is initially used by EasiSlides to hold song number references for the 
song in Songs of fellowship, Complete Mission Praise and The Source. For example, the song 
All Heaven Declares will have the Book Reference of “SF10, MP14, TS8” which means the 
song is at: 
- Songs of Fellowship No. 10 
- Complete Mission Praise No. 14 
- The Source No.8  

7. The User Reference is a user field for you to use for whatever purposes you want. The 
Search option can search on this field.  

The Song Lyrics: 

1. You can use the  button, or use drag and drop to drag, to import a Word or text document 
from a Windows folder into the Lyrics area. If so, the Document name will become the Title 
and the contents of the Word/text Document will be inserted into the Lyrics Area.  

2. Type up the lyrics for the song in the Lyrics Area . There are two Lyrics areas - Region 1 and 
Region 2. Use the following buttons to indicate verse number, chorus, etc. (Note: Apart from 
the New Screen indicator, all other indicator can only appear once in the lyrics)  

 .. Insert a Verse Number heading

 Insert Chorus/Chorus2 Heading

  Insert Bridge/Bridge2 Heading

  Insert PreChorus/PreChorus2 Heading

Insert Ending Heading

Insert New Screen - this actually inserts a blank 
line in the lyrics which is automatically 
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Please see EasiSlides Regions Explained for more information on 
Regions. 

3. The Sequence information  tells EasiSlides the order the various verses, chorus, bridge, 
ending are to be sung. If you leave the Sequence blank, EasiSlides will show the lyrics in the 
order the lyrics are typed in. Use the following buttons to arrange the Sequence as 
appropriate: 

4. To add Notations, insert a blank line above the line of lyrics and at the blank line, click the 

 button which will insert the notation symbol into your blank line. Now add your notations 
as desired. Typical notations are guitar chords. An alternative way to add guitar chords is 
to click on the lyrics where you want a guitar chord to appear above it, then right click mouse 
and select from list of available chords. You will need to ensure the  button is clicked to see 
the guitar chords popup menu. Below is an example of chords for the song "Away in a 
manger": 

 

5. The Verse Format  button  is for translating simple verse indicators to EasiSlides format 
one. Below is an example of text with simple verse indicators on the left and clicking the 
Verse Format button to produce the result on the right: 

translated to a New Screen during the Show.

  Undo, Redo typed text 

Add the selected indicator(s) to the Sequence List 

Smart-Add all the indicators to the Sequence List. 
EasiSlides will make an educated guess at what the 
Sequence should be.

 
Rearrange the order of the selected item in the 
Sequence List

Remove the item from the Sequence List

Page 9 of 28Database Features

24/08/2006file://C:\Documents and Settings\Mo\Local Settings\Temp\~hh4B85.htm



 

6. If you wish, you can use the ,  buttons to transpose the guitar chords you have typed. If 
you had selected a capo setting and/or a Song Key, EasiSlides will also transpose those 
settings for you.  

7. If you type in Chinese, you can use the  button to switch your Traditional Chinese text to 
Simplified Chinese and vice versa.  

8. If you wish to set up Rotate Timings for the Song, please read the article Setting Rotate 
Timings.  

9. Click the  to save the Song to the Database. The system will inform you if there is an error 
in the lyrics or squence. If there are no errors, the system will save the song to the EasiSlides 
database.  

Setting Rotations:  

For information on Rotations, please see the topic Setting Rotations. 

Note 1: InfoScreens are actually XML Text Files with some EasiSlides formatting information. The 
files are stored in C:\EasiSlides\InfoScreens and therefore you may, if you wish but with caution, 
use Windows to amend, delete, rename them as desired. 

Note 2: When transposing chords, EasiSlides will only consider the letters A to G  as a chord if there 
is a space, a "/" (for Bass), a "[" or a "{" before it. For example [G] is Chord G, as is {G}, as is G 
on its own. However, CG will only be considered as Chord C because the G after it is assumed to be 
part of C because there is no space in between. However C/G will both be transposed because C is 
the Chord and G is the Bass Note. Please be aware that you can not use the symbols "(" and ")" in 
the Notations because it is used by EasiSlides as internal indicators.  

Note 2 : With the first press of the  switch, if the text is either completely Traditional Chinese or 
a mixture of Simplified/Traditonal Chinese, EasiSlides will switch all the text to Simplified Chinese. If 
all the text had been Simplified Chinese then EasiSlides will switch all text to Traditional Chinese. 

  

Play Media 

You can play Media Files either from the Songs List directly at the EasiSlides Main Windows, or play 
it as a background during a EasiSlides LIVE Show. 

1. Play Media File Directly at the Songs List  

1. Locate the desired item from the Songs Folder on the EasiSlides main Window left pane.  
2. If the symbol "<#>" appears against the item you want in the Songs List, it means there is 
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an associated Media file for the item. If there is not, follow the instructions Associating 
Media File To Title (below) to associate the file.  

3. If there is an association, select the desired item on the Songs List and click the  button.  
4. Windows should automatically play the media file using the Media Software, such as Windows 

Media Player or Real Player, you had set up on your PC.  

2. Play Media File during a Live Show  

You can set a media file to play during a Live Show via three methods:- 

? Media Tab  
? Default Settings  
? Individual Settings  

Media Tab: 

1. At EasiSlides Main Window Left Pane, select the Media tab.  
2. Click on the desired media file you wish to play during a Live Show.  
3. Click the Middle Pane Set button and if it is not checked, click the Individual Settings 

checkbox to enable Individual Settings  
4. Click the Media : button.  
5. Under Settings, you can set various sound settings (for Live Feed, only DV connections via 

firewire will have sound). Also you can set the media file to repeat from the start when it 
finishes, set the video to widescreen (if video and if the video file does not contain proper 
widescreen indicator but is a widescreen file).  

6. If you have chosen a valid media file option, you can click the Play button to listen/view the 
media option you have chosen.  

7. After you are selected and entered your media details, click OK  to save the details. You will 
be returned to the EasiSlides Main Window.  

8. Now add the item to your worship list by clicking the  button.  
9. During a Live Show, this media file will play automatically when it is Live.  

Default Settings: 

1. At EasiSlides Main Window Left Pane, select the Default tab.  
2. Click the Media : button.  
3. When the Assign Media Window appears, select your Source option:- 

? No Media  - Don't play an Media when this item is live.  
? Play Media Based on Item Title - If there is an Associated Media File with the Item, that 

associated Media File will be played when the item is live. See Associating Media File 
To Title (below) for more information about associating media files.  

? Specific - Enter the full location path of the media file you wish to play when the item 
is live.  

? Live Feed From  - Select the attached Video Input device, if any. If it is a valid Video 
Input device, such as a camcorder, the video from that device will be displayed on 
screen when the item is live.  

4. Under Settings, you can set various sound settings (for Live Feed, only DV connections via 
firewire will have sound). Also you can set the media file to repeat from the start when it 
finishes, set the video to widescreen (if video and if the video file does not contain proper 
widescreen indicator but is a widescreen file).  

5. If you have chosen a valid media file option, you can click the Play button to listen/view the 
media option you have chosen.  

6. After you are selected and entered your media details, click OK  to save the details. You will 
be returned to the EasiSlides Main Window.  

7. Now add the item to your worship list by clicking the  button.  
8. During a Live Show, any items on the Worship List which doesn't have its own individual 

settings will be assigned with the default media settings and the media file will play 
automatically when that item is Live. (See Note 7)   

9. More information on Default Settings are found at Default Settings.  
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Individual Settings:  

1. At EasiSlides Main Window Left Pane, select an item either on the Songs List or on the 
Worship List.  

2. Click the Middle Pane Set button and if it is not checked, click the Individual Settings 
checkbox to enable Individual Settings  

3. Click the Media : button.  
4. When the Assign Media Window appears, select your Source option:- 

? No Media  - Don't play an Media when this item is live.  
? Play Media Based on Item Title - If there is an Associated Media File with the Item, that 

associated Media File will be played when the item is live. See Associating Media File 
To Title (below) for more information about associating media files.  

? Specific - Enter the full location path of the media file you wish to play when the item 
is live.  

? Live Feed From  - Select the attached Video Input device, if any. If it is a valid Video 
Input device, such as a camcorder, the video from that device will be displayed on 
screen when the item is live.  

5. Under Settings, you can set various sound settings (for Live Feed, only DV connections via 
firewire will have sound). Also you can set the media file to repeat from the start when it 
finishes, set the video to widescreen (if video and if the video file does not contain proper 
widescreen indicator but is a widescreen file).  

6. If you have chosen a valid media file option, you can click the Play button to listen/view the 
media option you have chosen.  

7. After you are selected and entered your media details, click OK  to save the details. You will 
be returned to the EasiSlides Main Window.  

8. Now add the item to your worship list by clicking the  button.  
9. During a Live Show, the selected media file will play automatically when that item is Live. 

(See Note 7)   
10. More information on Individual Settings are found at Individual Settings.  

Note 1. If you have adjacent items on the Worship List which have the same media option and 
filename, EasiSlides will play the media continuously without any interruptions. This is useful if you 
want to show one common video/audio background for a series of items (such as announcements). 
This is applicable to both Default Settings and Individual Settings. 

Note 2. The repeat setting is not the same as repeating the item during a Live Show. The repeat 
setting here is used for repeating the media only. If not set, the media will stop when it finishes 
even you still have the item on screen. If you want to repeat the item (going through each slide 
automatically) please see Settings Rotations for details.  

3. Associating Media File To Title  

If you wish EasiSlides to identify a media file for a particular item on your Songs List or Worship 
List, you need to set up an association between the media file and the item in EasiSlides. This 
involves a one-off task to do all your existing media files and then as an on-going task when you 
add new media files to your PC. 

1. Copy all the media files you wish to use in EasiSlides to the EasiSlides media Folder. This 
folder is, by default, set to c:\EasiSlides\Media\. You may, if you wish, point to an 
alternative location instead via View->Options->Main Window.  

2. You can create Sub Folders within the EasiSlides Media Folder to hold your media - EasiSlides 
will search all subfolders within that Media Folder when associating Media Files.  

3. Go through each media file in your EasiSlides Media Folder and rename it to the exact name 
you have for the Song Titile of the Song stored in EasiSlides. For example, if there is a Song 
Title "When I Survey" and you have a media file for that song, you must rename that media 
file to " When I Survey".  

4. If the Song Title is in a language other than English, especially if it was a CJK -language, you 
are recommended to type in the English Title of the song in Title 2 of the Song, and rename 
the media file to the Title 2. If EasiSlides can't match Title 1, it will automatically try to 
associate a media file using Title 2. (Please note that Powerpoint, Word and text items in 
EasiSlides don't have the option of Title 2)  
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5. If you have done all the above correctly, when you list the songs in the EasiSlides Left Pane, 
the "<#>" symbol will appear against songs which have an associated media file.  

6. When you add new media files to your PC in future, you should repeat steps 3 and 4 for your 
new media files.  

Note 3. There is actually nothing to stop you using non-English Media file names in EasiSlides. 
However, you may come across certain problems when dealing with those files outside of EasiSlides 
such as:- 

? Some Windows software tools don't support unicode filenames and therefore you might have 
problems transfering those media files to another computer.  

? Copying non-English filenames to older versions of Windows may not be possible.  
? Some zip programs and CD burner don't support unicode filenames and therefore you will 

have difficulty in zipping the media files or burning the files to CD/DVD.  
? Older versions of Windows media players will not recognise Unicode filenames and therefore 

might bring up an error when trying to locate and play the file.  

Note 4. Media files are recognised by their file extensions. EasiSlides uses two lists to hold 
extensions of known media files which plays under DirectX. You may, if you wish, amend those two 
lists to add/remove media file extensions. The two lists are normally held at 

? C:\EasiSlides\Admin\Database\AudioExtensions.txt  
? C:\EasiSlides\Admin\Database\VideoExtensions.txt  

Note 5. When EasiSlides looks for an associated media file to play, it will look for file extensions 
listed, in the, in AudioExtensions.txt. If it can't find any associated media files, it will look in for file 
extensions listed, in order, in VideoExtensions.txt. So, if you have two media files with the same 
name but different extensions, EasiSlides will use the media file with the extension it finds first in in 
AudioExtensions.txt and if it is not there, in VideoExtensions.txt. 

Note 6. Please note that on some system you will need to set your Windows Display to 24-bit 
colour or lower for Video files to be displayed properly. This is a issue associated with the 
Microsoft 2.0 .NET Framework. Alternatively, if you use Dual Monitor and you are playing a Video 
File chosen from the Media Tab, you can run in 32-bit colour so long as you have Options->Show-
>No Panel Overlay for Media ticked. 

Note 7. The Media File will only start to play automatically if your have Auto-Rotate set on. If Auto-
Rotate is off, you can manually start the Media by pressing the F5 Key. For more details on 
rotations and navigation keys, please see Setting Rotations and Shortcut Keys During the Show. 

Individual Format 

Apart from Powerpoint files, you can set individual formats for all the items used in EasiSlides. To 
format an item,  

1. Click the item on either the Songs List, worship List or from the Bible Passages.  
2. when the item appears in the Preview Window, click the Set  button.  

 

Select a song on the Worship List by clicking on it once. Then click the option "Use Individual 
Settings": 

 

Load and Apply a Template to Current Preview Item. You can apply settings from a previously 
saved template to the current item.
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The following setting are available: 

 

Save Current Preview Settings to a Template. This will save your current settings to a 
template which you can re-use later.

? No Headings - Do not show any headings  
? Show All Headings - Show Title, Verse Numbers and Other headings  
? Heading At First Screen Only - Only Show Title at the first showing of the item  

? Region 1 Only - Show Region 1 text only (if any)  
? Region 2 Only - Show Region 2 text only (if any)  
? Regions 1 & 2 - Show both Region 1 and Region 2 text (if any)  

? Align Top - Align text to the top  
? Align Centre - Centre text in the middle between top and bottom  
? Align Bottom - Align text to the bottom  

? Use Shadow Font  

? Use Outline Font  

? Interlace Region1 and Region 2 text (if any)  

? Show Notations (if any) - Please see Note 1 below.  

? Align Headings As Region 1 text alignment  
? Align Headings As Region 2 text alignment  
? Align Headings Left  
? Align Headings Centre  
? Align Headings Right  

? Transpose Chords Up/Down  

? Do Not Show Display Panel data (overriding Display Panel overall Settings but 
respecting Enforce Display of Copyright setting)  

? Tile Background Image - Tiling effect depends on the size of the original image  
? Centre Image - Enlarge/Reduce Image to see the whole picture (May leave border at 

screen edges)  
? Best-Fit Image - Enlarge/Reduce Image just enough to leave no border at edges  

? Clear Background Image  

  ? Set Background Colours  

  ? See Play Media for Details  

  ? Item Transistion - set the transition of the item when it is first shown  
? Slide Transistion - set the transition between each slide of the item  

 
? Set Left Margin of the text  
? Set Right Margin of the text  
? Set Bottom Margin of the text  
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? Set Font, Colour, Alignment, Vertical Position and Colour for each Region  

Note 1: A feature of EasiSlides is that if you have three dashes (" ---") or more in your text, 
EasiSlides will consider them to be place-holders for Notations. If you have Show Notations on , 
those dashes will be displayed as part of the text. If you have Show Notations off, those dashes 
will be hidden. This feature also applies to generated RTF documents.  

Note 2 : Changes to Individual Settings are saved automatically to the Database. Therefore, if you 
remove the item from the worship list, the next time you click on the item at the Songs List, the 
previously stored individual settings for the item will apply. In the same way, if you untick the 
Individual Settings checkbox, the settings for the item are also removed from the database. If you 
want to clear all the individual settings from the database, you can do so by using the option Clear 
All Formatting in the Database.  

Session Settings - click here for more information 

Default Formatting 

Default Formatting are applicable to ALL items except those with Individual Settings. At the 
EasiSlides main menu, select the Default  tab. 

 

If you wish, you can click the Apply to All Except InfoScreens button to remove all individual 
items settings from all items on the Worship List excluding InfoScreen Items. The following Session 
settings are available: 

 

Load and Apply a Template to Current Session. You can apply settings from a previously 
saved session template to the current session.

Save Current Session Settings to a Template. Note that if you choose a file name of 
"Default", all further new Worship List be automatically use the settings based on the 
"Default" template.

? No Headings - Do not show any headings  
? Show All Headings - Show Title, Verse Numbers and Other headings  
? Heading At First Screen Only - Only Show Title at the first showing of the item  
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Display Panel Settings  

 

? Region 1 Only - Show Region 1 text only (if any)  
? Region 2 Only - Show Region 2 text only (if any)  
? Regions 1 & 2 - Show both Region 1 and Region 2 text (if any)  

? Align Top - Align text to the top  
? Align Centre - Centre text in the middle between top and bottom  
? Align Bottom - Align text to the bottom  

? Use Shadow Font  

? Use Outline Font  

? Interlace Region1 and Region 2 text (if any)  

? Show Notations (if any) - Please see Note 1 below.  

? Transpose all Chords, if any, to Capo 0  

? Align Headings As Region 1 text alignment  
? Align Headings As Region 2 text alignment  
? Align Headings Left  
? Align Headings Centre  
? Align Headings Right  

? Align Region 1 and Region 2 text  

  ? Set Colours of Region 1 and Region 2 Text  

? Tile Background Image - Tiling effect depends on the size of the original image  
? Centre Image - Enlarge/Reduce Image to see the whole picture (May leave border at 

screen edges)  
? Best-Fit Image - Enlarge/Reduce Image just enough to leave no border at edges  

? Clear Background Image  

  ? Set Background Colours  

  ? See Play Media  for Details  

  ? Item Transistion - set the transition of the item when it is first shown  
? Slide Transistion - set the transition between each slide of the item  

? Set Panel Text Colour as Region 1 text colour  
? Set Panel Text Colour if colour is not as Region 1  

? Set Transparent Panel Background  
? Set Panel Background Colour if background is not transparent  

? Show Display Panel  

? Show Title  

? Show Copyright Information (Please note that EasiSlides will show copyright information 
on first showing regardless of your setting here if Options->Copyright->Enforce 
Display of Copyright setting is ticked)  

? Show Item Position and Item Count on Worship List  

? Show Slide Position and Slide Count of current item  

? Show Titles of Previous and Next Items on the Worship List  

  ? Display Panel height (%) relative to Screen Height  
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Note 1: A feature of EasiSlides is that if you have three dashes (" ---") or more in your text, 
EasiSlides will consider them to be place-holders for Notations. If you have Show Notations on , 
those dashes will be displayed as part of the text. If you have Show Notations off, those dashes 
will be hidden. This feature also applies to generated RTF documents.  

Note  2: Each Session can have its own Session Settings and therefore the changes made here are 
only applicable to the current Session. 

Generate Worship List Document 

This option produces a RTF (Rich Text Format) document, which can be opened by MS Word and 
Wordpad, with the lyrics of all the songs on the Worship List. You can then print the a printer if you 
wish.  

This option provides the Worship Leader, and others in the Worship Team, a formatted copy of the 
songs to be sung. This facility also provides a measure of contingency in a situation where the video 
projector is not working, and you can use EasiSlides to produce a formatted copy of the songs to 
the congregation (you will need printer/photocopier of course!). 

To generate a Worship List Document: 

1. When you are satisfied that the Worship List is complete, click the  button.  
2. Set formatting options for the document as desired.  
3. Click the Generate  button to generate the document, or Index Only  button to generate a 

list of index only, or Titles & Ref  button to generate a summary of Titles and References.  
4. Once the RTF document is generated, it will be opened automatically by Windows using either 

MS Word (if you have it), or by other RTF-default editors (such as Wordpad) on your PC.  

Note: Some document editor such as Wordpad might not fully-implement RTF-documents and 
therefore you may not get multi-column formatting. Other items such as font size, etc. should be 
OK.  

Format the Worship List Document 

The following formatting options are available for generating your RTF Document: 

? Fonts Formatting/Size  - this sets the appearance (bold, underline, italic, size, colour) of 
the fonts on the Document for the Song Number, Song Title, Copyright Information, Verses, 
Chorus/Bridge, Notations.  

? Show Details - use this to indicate whether or not you want Song Number, Song Title, verse 
Number, Copyright Information, Chorus Indicator, Bridge Indicator, Book Reference, User 
reference, Notations to appear in the document. The Capo 0  option is to force all Guitar 
Chords to transpose to the Key where no capo is required, ie. the Key/chords shown will be 
for use by a pianist. The Printer Spaces  option is for adding blank spaces in the Notations so 
as to minimize alignment problems in Word 2000 (or earlier) when printing Notations.  

? Regions - use this to indicate which region's text you want to output.  

? Columns - use this to indicate if you want single column or double-column output. Please 
note that some RFT editors such as WordPad does NOT display double-column text.  

? Lyrics Pattern - use this to indicate how the song lyrics are presented: 
? Basic: Output the way it is stored in the Database, ie. don't use the Sequence Order  
? Sequence: Show lyrics with repeating chorus, etc. as per Sequence Order  

  ? Font Settings: Bold, Italics, Underline, Shadow, Outline and Font Name  
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? Size - select either A4  or Letter size for your generated RTF Document.  

? Line Spacing: 
? Between each line: Number of blank lines between each lyrics line  
? Between each song: Number of blank lines between each song  
? One Line Spacing per Screen break: Sometime, long verses are broken into 

seperate screens where there is a natural pause in the lyrics. If ticked, One Line 
Spacing will output a blank line for every screen break. If not selected, verses that are 
broken up will be combined together on the document.  

? One Song per Page : When ticked, a page break will be inserted after each item  

Click the Generate  button to generate the document, or Index Only  button to generate a list of 
index only, or Titles & Ref  button to generate a summary of Titles and References.  

  

  

Setting Region 2 in a Word Document/Text File 

You can also set Word and text documents so that the text is divided into Region 1 and Region 2. 
Lyrics for a song are normally typed up as follows (the example Cantonese song is “On A Hill Far 
Away”):- 

 

Note that in the above example, Verse 1 is split into two screens (the blank line in Verse 1 indicates 
a New Screen). 

To add English lyrics (or any other language lyrics):  

1. Insert the Region 2 ‘[region 2]’ indicator at the end of the current verse.  
2. Type the new verse in the language you want.   
3. Insert New Screen indicators where appropriate to match the original language. In the above 

example, there are two screens for verse 1 and therefore the second language lyrics verse 1 
should also have two screens.  

4. Repeat the above for the chorus and remaining verse, etc.  

The new lyrics should look something like the following: 
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During the Show, EasiSlides will automatically link the different screens under the different verses 
and chorus together as thus: 
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Options 

There are a number of options to change the way EasiSlides operates. To access the Options 
Window: 

From EasiSlides Main Window select  View->Options 

1. Main Window 
? Main Window Settings 

2. Show 
? Show Settings 

3. Monitor 
? Monitor Settings 

4. Alerts 
? Alerts Settings 

5. Folders 
? Folder Options 

6. Bibles 
? Bible Settings  

7. Licence 
? Licence Details 

8. Keyboard  
? Keyboard Options 

Main Windows Settings 

From the EasiSlides Main Window, click the  button. The Options Window will appear on screen. 
Click the Main Window tab. 

The following options are available: 
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1. Maximum Settings. Settings for the Maximum Number of Bible verses are displayed, 
Maximum Number of Bible Search Results and Maximum Number of Edited Items on 
the Recent edited list. The Bibles verse maximum used to control computing resources 
because selecting a large number of verses in one go may tie up the computer for a period of 
time. 

2. Powerpoint. Settings for the maximum number of Powerpoint Items are the Worship List. 
Having too many Powerpoint items during a Live Show may tie up computer resources for a 
period of time. There is also an option to turn Show/Hide the Powerpoint Tab on the 
EasiSlides Main Window Left Pane. 

3. Media Files. Specify the folder where EasiSlides will search and list Media Files. This is the 
location where EasiSlides will associate Media Files with the Song Titles listed in the Songs 
List area. There is also an option to turn Show/Hide the Media Tab on the EasiSlides Main 
Window Left Pane. 

4. Preview Text Areas. Use this option to set Font Size, Notations and Line Between Screens 
in the Preview Areas. You can also set focused colour for the area you click on - this is 
particularly useful if during a Dual Monitor Live Show, the colour will let you know which area 
you have clicked on and therefore any keyboard keys pressed will be for that area. 

5. Other Settings. The Show Lyrics Monitor Alerts Box will display a text box at the bottom of 
the Output Pane. Messages typed in at this box will be sent to the Lyrics Monitor (for the 
choir, etc) if your PC has the necessary hardware/software for this additonal monitor. To send 
a message, enter text and click . To clear the message, click . 

6. Jump To Folder Icons.  Select a song folder you wish to associate with each of these three 
options. The association will be set at the Main EasiSlides Window so that you can quickly 
jump to the associated song folder by the click of a button. 

Show Settings 

From the EasiSlides Main Window, click the  button. The Options Window will appear on screen. 
Click the Show tab. 

The following options are available: 

1. Text Settings. Auto Text Overflow  means EasiSlides will let text overflow to the next 
screen if they can't fit into one screen. 

? Use Largest Font means that whatever text is on screen will be displayed at the 
largest font size possible.  

? Line Between Regions will display a horizontal line in the Output between the Region 
1 and Region 2.  

? Indent Word Wrap Text will indent the second and subsequent lines of text which 
were word wrapped from the first line. This option does not apply to InfoScreens.  

? Size of Notaions to Folder Size sets the Notation font size in the Live Show based on 
a percentage of the Main Font Size for the item.  

2. Other Settings. 
? Advance Next Item  means that when you are at the last slide and you press the next 

slide key, EasiSlides will move onto the next item on the Worship List - or if you are at 
the first slide, the previous slide key will bring you to the previous item.  

? No Panel Overlay For Powerpoint means that when a Powerpoint Item is displayed 
during a Dual-Monitor Show, there will be no other EasiSlides information overlaid on 
top of it. Please see Note 1 below for more information.  

? No Panel Overlay For Media  means that when a Media File item is selected during a 
Dual-Monitor Show, there will be no other EasiSlides information overlaid on top of it. 
Please see Note 2 below for more information.  

? Disable Screen Saver During Show will ensure the Screen Saver, if set, does not run 
during a Live Show.  

3. Gap Between Items.  This option sets the Gap between each item on the worship list. 
? No Gap  means the next item is displayed when the next item key is pressed.  
? Black Screen means a Black Screen  will appear between each item.  
? Default Background  means whatever background you have set for the Default Setting 

will appear between each item, ie a coloured screen or an image.  
? User Defined Logo  lets you select a specific image file, such as a church logo, to 

display as the Gap Item.  
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? Use Fade Transition option means that the Gap Item is Faded in.  
? Please note the following features apply for different conditions:  

?

4. Video Background. This option sets the Video Size and Vertical Position of any Video Media 
you play during a Live Show. 

NOTE 1. There is an issue with displaying an overlay form (which EasiSlides does) on top of a 
Powerpoint Show if the colour setting is set to 32-bit colours. Normally for powerpoint to work in 
EasiSlides, you will need to set your colour depth to 16-bit colour. If you have dual monitor and you 
wish to keep using 32-bit colour, then you can switch off the overlay so that the Powerpoint Show 
can be seen. 

NOTE 2. There is an issue with displaying an overlay form (which EasiSlides does) on top of certain 
Media Files if the colour setting is set to 32-bit colours. If you cannot see your media file when it is 
played during a live show, you should switch to 16-bit colours or, if you have dual monitor, switch 
off the overlay. 

Monitors Settings 

From the EasiSlides Main Window, click the  button. The Options Window will appear on screen. 
Click the Monitors  tab. 

EasiSlides provides two monitor outputs if your PC has the necessary hardware or software to make 
use of them: 

1. Live Output Monitor. Select which monitor to use for the Live Show. The Always Attempt 
Secondary Monitor checkbox is used to tell EasiSlides to use Secondary Monitor if it is 
available, regardless of the monitor selected. If Primary Monitor is used, Live Show will be in 
single-monitor mode. If Secondary Monitor is used, Live Show will operate in Dual-Monitor 
mode. If you have a Single Monitor System which has a widescreen, you can use the Custom 
Settings and Act as a Single Monitor  option to ensure your projected output is at the right 
screen ratio and size. 

2. Lyrics Monitor. Select which monitor to use for displaying the lyrics for the choir praise 
leader. The Always attempt Secondary Monitor checkbox is used to tell EasiSlides to use 
Secondary Monitor if it is available, regardless of the monitor selected. You can use the 
Custom Settings to set a custom position for your Lyrics Monitor. Additionally, you can set 
the font size, colour and also enable/disable display of Notations.  

3. Live Cam Settings. If you have a Video Capture Device such as a camcorder attached to 
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your PC, you can select it as your Live Cam Device at the Live Cam Settings Box. Note that 
the Volume controls are only applicable to devices connected via a firewire (DV) input. During 
a LIVE Show, you can press the F4  key (or the  button if Dual Monitor) to show/turn off the 
live feed from the attached camcorder.  

Note.  For Live Cam Settings, please note that on some system you may need to set your Windows 
Display to 24-bit colour or lower for the Live Cam to be displayed properly. This is a issue 
associated with the Microsoft 2.0 .NET Framework. Alternatively, if you use Dual Monitor, you can 
run in 32-bit colour so long as you have Options->Show ->Live Cam Settings->No Panel 
Overlay for Live Cam ticked. 

Alerts Settings 

From the EasiSlides Main Screen, click the  button. The Options Window will appear on screen. 
Click the Alerts tab. 

The Alerts Options allow you to set the following properties:  

1. Message Alert Settings.  Set Message Alerts settings for showing during a Live Show. You 
can set Font name, style, vertical/horizontal alignment, colour, background colour, duration, 
scroll and flash the message. 

2. Parental Alert Settings.  Set Parental Alerts settings for showing during a Live Show. You 
can set Font name, style, vertical/horizontal alignment, colour, background colour, duration, 
scroll and flash the message. Main difference between Parental Alert and Message Alert is that 
you can set a pre-typed Header text for the Parental Alert.  

3. Reference Alert Settings. Set Reference to display when the item is first shown. You can 
either display the Title, Song Number, Book Reference or User Reference. Use Pick & 
Substitute  to replace the displayed text with something more appropirate. 

? For example, For Abba Father , Book Ref is “SF1, MP3, TS1 ”. You can select to show 
that Book Ref, or enable Pick & Substitute  and Pick “MP”, Subsitute “Mission Praise ” -
the result will be " Mission Praise 3" being displayed at the start of the song.  

? Other options include setting Font name, style, vertical/horizontal alignment, colour, 
background colour, duration, scroll and flash the reference.  

NOTE 1. Please see Message/Parental/Lyrics Alerts for details on displaying an alert during a Live 
Show  

Folder Options 

From the EasiSlides Main Screen, click the  button. The Options Window will appear on screen. 
Click the Folders tab. 

You can update settings for each Song Folder: - 

1. Select Folder by clicking on the desired folder on the Folder list. Click the Use Folder  
checkbox if required. 

  

2. Rename  the selected Folder. Click the Folder you want to rename, then either click the 
Rename  button or press F2 on the keyboard. Enter the name desired and press Enter on the 
keyboard. Note that the Windows name of the said folder within the EasiSlides Folder will also 
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be renamed.  
3. Header Font lets you set the format and size of the Header based on the Main Font size. Use 

the drop down option plus the Additional formatting buttons to set the header font format:- 

 

? Use Region 1 Settings - The Header formatting will be as that of Region 1 Font  
? Use Region 1 plus formatting below - The Header formatting will be based on that 

of Region 1 Font plus the additional formatting settings.  
? Use Only formatting below - The Header formatting will be based entirely on the 

additional formatting settings.  

?  Italics options are:- 
? No Italics - NONE of the Headings will be in italics  
? Italics - ALL the headings will be in italics  
? Chorus Italics Only  - Only the Chorus, PreChorus, Bridge and Ending Heading 

will be in italics. The Main Title and Verse headings will not be in italics.  
4. Region Positions for the selected Folder. Click the Folder you want to set lyrics positions for. 

Click the Use Folder checkbox if required. Change the position settings for the Region 1 or 2 
lyrics, or change Left/Right margins, as desired by using the up/down buttons in the Region 
Positions box. Click on another Folder to change other settings if desired: 

 

5. Set Font, Bold, Italics, Underline, Right-To-Left and Size for the Selected Folder. Click 
the Folder you want to set font settings. Click the Use Folder checkbox if required. Change 
the font settings for the Region 1 or 2 lyrics as desired. Click on another Folder to change 
other settings if desired: 

  

?  Italics options are:- 
? No Italics - NONE of the text will be in italics  
? Italics - ALL of the text will be in italics  
? Chorus Italics Only - Only the Chorus, PreChorus, Bridge and Ending Text will 
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be in italics. Other text will not be in italics.  

?  Right-To-Left (RTL) option  is for languages which are written right-to-left. If set, 
when you open a database or infoscreen screen which is from a RTL folder, the editor 
will be set to RTL. The songs list for an RTL folder on the EasiSlides Main Window will 
also be listed RTL. 

6. Set Chorus, etc. Headings for the selected Folder. This option allows you to type in the 
headings, in your own language, for the PreChorus, Chorus, Bridge and Ending Headings. The 
Headings stored here will be used by the Show, PraiseBook Generator and HTMLGenerator. 
Click the Folder you want to set the heading for. Click the Use Folder checkbox if required. 
Type/Paste in the headings for Chorus, Bridge and Ending as desired, or by selecting one 
from the list of choices provided. Click on another Folder to change other settings if desired: 

 

7. Set Text Line Spacing for the selected Folder. This option lets you set the line spacing 
between each line of the lyrics for Region 1 and Region 2:  

 

  

Note 1: Details on how to re -arrange Folders are available under Re-arranging Song Folders 

Bible Settings 

From the EasiSlides Main Screen, click the  button. The Options Window will appear on screen. 
Click the Bible tab. 

The Bible Settings allows you to install EasiSlides-formatted Bibles into EasiSlides: 

To Search and Add Holy Bible: 

1. Download the Bible files from the EasiSlides website and follow the supplied instructions. The 
Bibles will be placed in the EasiSlides HolyBible Folder. 

2. At the Add Holy Bibles section on the Bible Settings tab, click Search. A List of Bibles will 
appear. Click on the desired Bible on the list and click Add. The selected Bible will be now 
appear in the Current Bibles in EasiSlides section. 

3. You can now either click OK to save and exit the options or format the Holy Bible as per 
instructions below. 

Format Holy Bible: 

1. In the Current Bibles in EasiSlides section, click on the Bible you wish to set formatting 
for. 

2. In the Use Song Folder Setting  section, associate a song folder to the Bible. The font 
settings, etc. for the selected Song Folder will apply to the Bible. Decide also on the 
percentage Font Size. The displayed Bible Verses font size will be based on the set percentage 
of the associated Song Folder font size . 

3. Click OK to save and exit the options.  

Page 25 of 28Database Features

24/08/2006file://C:\Documents and Settings\Mo\Local Settings\Temp\~hh4B85.htm



Licence Details 

From the EasiSlides Main Screen, click the  button. The Options Window will appear on screen. 
Click the Licence tab. 

The Licence Details allows you to associate Licence Numbers to songs. Many of the English songs in 
EasiSlides are administered by CCLI and in EasiSlides, those songs would have an indicator to show 
that they are CCLI songs. You can use the Licence Details to store your CCLI Number so that when 
a CCLI song is displayed, your CCLI Licence Number is also shown, so as to be compliant with CCLI 
instructions. 

To enter the details 

1. Enter the Administrator Details where appropriate. For ease of use, Blank, Public Domain, and 
CCLI have been pre-set. 

2. Enter the Licence Number against the Appropriate administrator. 
3. As soon as you type in Licence Number, a preview of how it will appear during a Live Show 

will be shown beside the number.  

You can also change the Number symbol which appears between the Administer Details and the 
Licence Number. By default the symbol is "#". You can put spaces around the symbol if so desired. 

Display of Copyright Information  

Organisations such as CCLI also require you to display the Copyright and Writer information (in 
addition to your CCLI Number) when lyrics of songs which they have copyright over are projected or 
copied. If you have the Display Panel turned off (or Copyright turned off), EasiSlides will still display 
the copyright data when the lyrics is shown for the first time but will automatically turn it off on 
subsequent slides.  

If you are based in a region of the world where the licencing authority does not apply, you can 
untick  the Enforce Display of Copyright On First Showing  option. This means if you have the 
Display Panel turned off (or Copyright turned off), EasiSlides WILL NOT display Copyright data at all 
even if such data is present in the database. 

Note: When you store your Licence Numbers, such as CCLI Number, they are stored in the Registry 
of your PC. Therefore, if you transfer/copy your songs database to another PC, you will have to re-
enter the Licence details on the other PC. 

Keyboard Settings 

From the EasiSlides Main Screen, click the  button. The Options Window will appear on screen. 
Click the Keyboard tab. 

The Keyboard Option allow you to set which set of keys to use for moving between items and slides. 

Default Keys: 

Default Keyboard Keys Action

Home First Song

End Last Song

Page Up Previous Song

Page Down, Tab Next Song

Up Arrow First Slide

Down Arrow Last Slide

Left Arrow Previous Slide
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Alternative Keys: 

  

  

EasiSlides Regions Explained  

EasiSlides can show two different languages, within an item, at the same time.  It does this by 
having two regions on the screen, with Region 1 being allocated to the normal lyrics, and Region 2 
being allocated to the second language. 

A song with Region 2 lyrics will appear as thus during the EasiSlides Show: 

 

The above shows the Cantonese lyrics in Region 1 and English Region 2.  When you type up your 
Song, or when you use the EasiSlides Smart Merge, you can decide which lyrics goes into which 
region. You can set Region 2 text for Database/InfoScreen Item and in a Word/Plain Text 
Document:- 

? Database/InfoScreen item  
? Word Document/File File  

  

Setting Region 2 in a Database/InfoScreen Item  

Where required, you can add Region 2 lyrics and indicators whilst you are editing, or adding a 
Database song/InfoScreen.  If you are using the EasiSlides Editor or InfoScreen Editor, you simply 
type up your Region 2 text in the Region 2 area. For each Verse/Screen Break in Region 1, you 

Right Arrow, Space Next Slide

Alternative Keyboard Keys Action

Home First Slide

End Last Slide

Page Up Previous Slide

Page Down, Space Next Slide

Up Arrow First Song

Down Arrow Last Song

Left Arrow Previous Song

Right Arrow, Tab Next Song
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should have a corresponding Verse/Screen Break Region 2. To assist you in keeping Region 1 and 

Region 2 screens/verses in sync, you can use the  keys which will highlight each synced screen 
in step. 

Storing and Formatting Dual-Region Lyrics:- 

? Dual-Language songs, ie. Songs with Region 2 lyrics, should be stored in their own 
separate folder.   Also, different dual-language  sets, ie. English/Cantonese, 
Cantonese/Mandarin, etc. should also be stored separately.  The reason for this advice is that 
different languages require different font sizes when projected. For example, English lyrics 
using the Arial font will project well using font size 36 – 40. However, Cantonese lyrics using 
MingLiu font will probably need font size 40 – 50.  Other languages and font types will also 
affect the font size required.  

? EasiSlides Options provides you the option to set the font and lyrics position for 
each Folder and each region within the Folder.  For example, if you store all the 
Cantonese/English dual lyrics songs in Folder 4, you can set the correct font type and size for 
the Cantonese lyrics for Folder 4 Region 1, and also independently set the English lyrics font 
size and type for Folder 4 region 2.  Consequently, all the songs storied in Folder 4 will have 
the stored settings.  

? EasiSlides Auto-Sync.  EasiSlides will assume that each line of lyrics in Region 1 will 
correspond directly to its equivalent line in Region 2. Therefore if lyrics overflows to the next 
screen, auto-sync will match Region 1 and Region 2 line by line.  
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